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SOFTWARE LICENSE STATEMENT 

This manual, software and electronic circuitry are protected by international copyright laws.  Under the copyright laws, this 
manual, software and electronic circuitry may not be copied, in whole or in part without written prior consent of SmartLink 
International, except in the normal use of the software to make an archival copy of the software for the sole purpose of 
backing up the software and protecting your investment from loss or damage. 

 
LIMITED WARRANTY 

With respect to the physical documentation and physical electronic circuitry enclosed herein, SmartLink International 
warrants the same to be free of defects in materials and workmanship for a period of one year from the date of purchase.  
In the event of notification within the warranty period of defects in material or workmanship, SmartLink International will 
replace the defective diskettes, documentation and electronic circuitry.  The remedy for breach of this warranty shall be 
limited to replacement and shall not encompass any other damages, including but not limited to loss of profit, and special, 
incidental, consequential, or other similar claims. 
SmartLink International specifically disclaims all other warranties, expressed or implied, including but not limited to implied 
warranties of merchantability and fitness for a particular purpose with respect to defects in the documentation and 
electronic circuitry, and the program license granted herein, in particular, and without limiting operation of the program 
license with respect to any particular application, use, or purpose. 

 
COMPLIANCE NOTICES 

AUSTRALIA: Where applicable, to ensure compliance with ACA Technical Standards, this equipment is labelled with a 
Telecommunications Compliance Label.  For safety reasons, this equipment should only be connected to compliant 
telecommunications equipment in accordance with the manufacturer’s instructions. 
EUROPE: Where applicable, this equipment has been approved to (Council Decision 98/482/EC_CTR21) for pan-
European connection to the Public Switched Telephone Network (PSTN).  However, due to individual differences in the 
PSTN for each country, this does not of itself guarantee successful operation on every PSTN termination point. 
NORTH AMERICA:  Where applicable, this equipment has been tested and found to comply with FCC Rules and 
Regulations, Parts 68 and 15 with the limits of a Class B digital device, designed to provide reasonable protection against 
harmful interference.  This equipment generates uses and can radiate frequency energy and if not installed and used in 
accordance with the instructions, may cause interference harmful to radio communications.  On the base of the 
equipment is a label containing an FCC Registration Number, if applicable. 
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1 ABOUT SMARTWATCH XP 

 
 

1.1 Features 
SmartWatch XP represents the single most significant achievement in the history of wireless 
messaging, marking the beginning of the next phase of evolution for messaging systems. 
SmartWatch XP is a messaging platform designed for Microsoft Windows ® enabling the seamless 
integration of all forms of text messaging. Whether you are dealing with an on site paging system, 
Short Message Service, email or DECT - SmartWatch XP can deliver messages effortlessly. 

SmartWatch XP integrates with a myriad of third party systems such as fire alarms, security systems, 
nurse call and building management systems enabling alarms to be directed immediately to the 
appropriate staff. In addition, messages may be initiated from any PC on the network or via a 
telephone interface. 

Client Server Architecture 

SmartWatch XP is a true client/server application with dynamic, real time updating of all database 
modifications from any PC on your network. By utilizing TCP/IP, clients may be connected to the 
server via the LAN, WAN or remotely via the Internet. As each client makes modifications to the 
centralized database these alterations are reflected instantaneously to all clients. This approach 
enables any PC (with sufficient security clearance) to make modifications to any aspect of the 
system, regardless of whether they are adding pagers, booking reminder messages or even 
performing maintenance. 

Message Dispatch 

Messages may be dispatched directly from PC’s either via the SmartWatch XP client software or 
directly from your email application. Users simply select who they wish to contact from a list of 
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recipients (or groups), type in their messages and click on send.  SmartWatch XP then determines 
how to send the message.  Access to on site pagers, citywide pagers, DECT handsets and mobile 
phones occurs transparently to the operator.  And being a non-dedicated application you can happily 
utilise your PC for other applications. 

PBX Interface 

A voice prompted telephone interface enables staff to send messages directly to recipients without 
the assistance of an operator.  The user is guided through the entire paging process via a series of 
voice instructions.  In addition, users may send a combination of predefined alphanumeric messages 
and numeric digits (such as ‘Call extension: 432’ or ‘Cardiac Arrest Room 432’). Messages may be 
prioritized for emergency conditions. 

Email Integration 

Email has become the communications medium of choice for the business community.  Around 40% 
of the average work force is mobile, and virtually all professional people have a mobile phone or 
pager.  SmartWatch XP embraces the email phenomenon enabling email messages to be sent 
directly to wireless recipients. In addition, SmartWatch XP is able to send messages directly to email. 
For example, when an alarm is activated it could send the message to a DECT handset and a copy 
of the alarm to your email address. 

Alarm Monitoring 

SmartWatch XP may be interfaced into numerous third party alarm systems enabling virtually any 
aspect of your premises or alarm conditions to be monitored.  Coupled with SmartWatch XP’s unique 
rostering and escalation system alarms may be dispatched to the appropriate staff depending on the 
time of the day, and which day of the week the alarm was activated.  Alarm information may be 
sourced directly from ‘intelligent’ serial or TCP/IP connections or via low level alarm inputs.  In 
addition, all alarms are logged to the hard disk for future reference and should an alarm not be 
resolved then SmartWatch XP can escalate the alarm to another recipient. 

City Wide Paging 

SmartWatch XP has been designed to communicate with commercial paging / SMS carriers to send 
messages directly to citywide pagers and mobile phones. By employing intelligent queuing 
techniques, SmartWatch XP can ‘batch’ calls together reducing outbound call costs. Furthermore, 
multiple SmartWatch XP systems can be networked together (via direct connections or via the 
Internet) to create ‘virtual’ wide area networks. This is ideally suited for sites that have multiple 
campuses and require contacting staff roaming between each of their sites. 

Recipient Management 

SmartWatch XP makes recipient maintenance a breeze for administrators.  Simply enter in the name 
of the recipient, their contact address and select how to send the message to them. 

All operations such as new, delete and save are situated on a single screen ensuring that all 
operations are only one click away. 

Rostering Management 

The rostering facility within SmartWatch XP enables different staff members to be contacted 
depending on what time of the day and which day of the week a call is placed to them. The rostering 
system is identical to traditional manual rostering. Rosters are highlighted in various colours so you 
can quickly see who is rostered on for a particular shift. 

When a call is placed to a roster (regardless of the origin) SmartWatch XP looks up which staff are 
on the roster schedule and then contacts all staff that are assigned to the shift. 
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Group Management 

It is often a requirement to notify more than one person at the same time. A typical example of this 
would be a fire alarm where, several people need to be informed simultaneously. 

Groups may consist of any combination of pagers, DECT handsets, mobile phones or citywide 
pagers. 

Adding members to a group is as simple as clicking on the add recipients button and dragging the 
required recipients into the group. 

Escalation Management 

Occasionally it is a requirement that a call unconditionally must be answered - if it is not then it could 
mean the difference between life and death. 

Under these circumstances SmartWatch XP employs escalation management and priority queuing. 
The escalation management enables a sequence of staff to be contacted, at varying time intervals, 
until the call is answered. In addition, the priority system ensures that the call is sent immediately, by 
moving it to the front of the queue. 

Email Integration 

Email has become the medium of choice for the business community. There is a clear need for 
mobile email services that staff can employ and configure to match their individual messaging needs. 

SmartWatch XP is both an email client (able to send emails) and an email server (able to receive 
email for dispatch to mobile recipients). 

Mobile email services take advantage of the ease with which mobile users can be reached.  The 
service monitors a user’s mailbox, detects the arrival of new email and notifies the user by sending a 
message to the user’s phone, pager or DECT handset.  In addition, any message that is generated 
by SmartWatch XP can be easily dispatched as an email. 

Alarm Monitoring 

SmartWatch XP can monitor a myriad of alarms such as door alarms, duress systems, building 
management systems, fire alarms and security systems. Alarms may be generated from virtually any 
source, either via a telephone line (Med-Call dialler units via an SCU Receiver), a direct serial 
connection (e.g. SmartWire and SmartLine), over TCP/IP or via Alarm Interface Modules. 

Once an alarm is triggered a message describing the alarm, its location and any other required 
information, will be instantly sent to the appropriate staff members. SmartWatch XP provides a full 
suite of rostering and call escalation capabilities that enables the system to determine which staff to 
page, depending on what time of the day the alarm was triggered. 

All alarms are logged to the hard disk providing confirmation of when, and to whom an alarm was 
sent. Furthermore, alarms may be sent to any combination of pagers, email addresses, DECT 
handsets and mobile phones. 

High Level Interface 

One of the primary benefits of SmartWatch XP is it’s inherit ability to be interfaced into third party 
systems. The ‘Generic Input’ interface inspects a serial data stream and searches for particular 
keywords. 

This facility enables it to communicate with virtually all alarm systems that maintain a real time log. 

Should a keyword exist in the data stream then SmartWatch XP may be configured to extract 
sections of the text to be sent to recipients. 

In addition to the ‘Generic Input’ interface several custom interfaces are also available. The two most 
predominant interfaces are the Nursecall and the gaming interfaces. 

SmartWatch XP enables you to establish a series of zones (wards in a hospital environment) so that 
you can assign staff to service particular areas within your premises. 

Whenever a call comes in from a particular zone, SmartWatch XP analyses which staff are assigned 
to the area, and if they are available, SmartWatch XP will contact them. 
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Staffing levels may be adjusted either automatically based on a roster schedule or manually by the 
staff on duty. 

Reporting and Statistical Analysis 

If there were one single ‘buzz’ word that has governed the past decade it would be accountability. 

Paging is one of the primary forms of communication within your organization – it is essential to be 
able to review and examine the paging traffic on your system. 

The reporting facilities available in SmartWatch XP provide management with the ability to: 

• Review response times to alarms. 

• Solve disputes on when and to whom messages were sent. 

• Track messages generated from particular sources – you can see which departments are 
busy. 

• In the event of litigation you can easily review what happened during a particular time 
period. 

• On screen graphical analysis allows management to review peak periods within your 
premises. 

 

1.2 About This Manual 
This manual is designed to assist electrical and electronic contractors to install SmartWatch XP. 

This manual is set out in a series of easy to follow step by step instructions followed by a checklist to 
confirm the steps as outlined.  Following the steps and checklists correctly will ensure that there will 
be no problems when installing SmartWatch XP. 

 NOTE: A note preceded with this symbol indicates secondary information pertaining to 
the topic under discussion. 

 IMPORTANT: A Right-pointing arrow followed by text in this manner presents important 
information. 

▲ WARNING: Warnings like this alert you to the fact that you might damage your 
equipment or lose data if you don't follow instructions carefully. 
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2 SMARTWATCH XP INSTALLATION 

2.1 Components 
Your SmartWatch XP package should contain: 

• SmartWatch XP Installation and Service Manual 

• SmartWatch XP Installation CD 

• Security Device (Dongle) 

2.2 Software Installation 
2.2.1 PCs and Operating Systems 

Specifications 

For the minimum and recommended hardware requirements refer to the readme.txt file on the CD-
ROM disk containing the SmartWatch XP files. 

Training 

A technician with knowledge of radio communications and electronic and electrical concepts is 
required to install the hardware (such as transmitters) included with your SmartWatch XP system. 

Installation of SmartWatch XP software requires a familiarity with the administration of Windows 
operating systems. 

 IMPORTANT: Please note that SmartLink will not provide technical support for 
equipment not provided by SmartLink. 

Windows Versions 

SmartWatch XP runs on any of the following Windows operating systems: 

• Windows 95 2nd Service Release 2 (Client Software Only) 

• Windows 98 2nd Edition (Client Software Only) 

• Windows ME (Client Software Only) 

• Windows NT 4 with Service Pack 6 installed 

• Windows 2000 with Service Pack 3 installed 

• Windows XP Professional with Service Pack 1 installed 

SmartLink recommends Windows NT, 2000 or XP based operating systems for the PC that will be 
running SmartWatch XP server. These operating systems are more secure, more stable and better 
manage system resources than 95, 98 and ME.  The significant performance advantages offered by 
these operating systems will prove especially beneficial if your SmartWatch XP system handles 
critical operations. 

Power Management 

The Windows operating system and your PC BIOS both provide the facility to reduce power 
consumption on your PC through a series of power management option. 

You will need to ensure this power management is disabled on the server PC, both in the BIOS and 
the operating system. 

▲ WARNING:  If you fail to disable power management on the server then you will 
experience problems with your SmartWatch XP system.  SmartWatch XP clients will be 
disconnected from the server if it sleeps or hibernates. 
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Power Management in Windows 

Launch the Power Management or Power Options item in the Control Panel (the actual name of the 
power management utility on your system will vary according to the version of Windows you are 
running and the brand of PC). 

 
 

Locate the settings for the current power scheme.  These will include system standby, turn off 
monitor and turn off hard disks, and perhaps also hibernate and other system options. 

Set the system standby, turn off hard disks and hibernate options to never occur.  You may wish to 
leave power saving for the monitor allowed (as illustrated in the screen above). 

Power Management in the BIOS 

The BIOS is a low level interface to the motherboard on your PC.  An experienced computer 
technician should confirm that BIOS power management is disabled on the server. 

▲  WARNING:  Do not attempt to make changes to the BIOS settings unless you are 
confident that you understand the changes you are making. It is a good idea to write 
down any changes you have made in the BIOS so they can be reset if needed. 
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2.2.2 Proxy Servers 
If you are running a proxy server then you will need to configure Internet Explorer to view the HTML 
online help on the server PC. 

▲ WARNING:  If you do not set up Internet Explorer correctly then the following error 
message will be displayed when you attempt to access the online help: 

Error: Connection to 127.0.0.1 failed: connection refused. 

If you encounter this error message on the server PC then you will need to bypass the proxy server 
for local addresses. 

 NOTE: This error will only occur on the server; you do not have to change the settings on 
clients. 

Bypass Proxy Server for Local Addresses 

To bypass the Proxy Server for Local Addresses, follow these steps: 

• Launch Internet Explorer. 

• Select Internet Options from the Tools menu. 

• Select the Connections tab. 

• Click the LAN Settings button to display the following screen: 

 
 

• If you are already using a proxy server then the Use a proxy server box should already be 
ticked, and the address and port of the server entered. 

• Make sure there is a tick in the Bypass proxy server for local addresses field. 

• Click [OK] to confirm the changes. 

• Click [OK] to exit the Internet Options screen. 

• Exit Internet Explorer. 
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2.2.3 Service Packs 
▲ WARNING:  If you are using Windows NT then you must ensure that Service Pack 6 has 

been installed. If you are using Windows 2000 then you must ensure that Service Pack 3 
has been installed. If you are using Windows XP then you must ensure that Service Pack 
1 has been installed. Every PC on your network that will run the server or client 
application under Windows NT must have these service pack upgrade. 

 IMPORTANT:  If you are unsure what Service Pack you have, or if you know that you 
have an old version, then you should follow the directions below. 
• Make sure that no other programs are running. 

• Place the SmartWatch XP Installation CD in the CD-ROM drive. 

• The auto-run screen will startup as shown below. 

 NOTE: If the auto-run screen does not startup, browse the contents of the CD-ROM drive 
containing the SmartWatch XP Installation CD using Windows Explorer or My Computer 
and double click autorun.exe. 

\ 
 

• Click the OS Service Pack button. The software will automatically detect what operating 
system you are running and if any updates are required. 

• Follow the instructions on screen. You will be notified when the service pack has installed 
completely.  Restart the PC to let the update changes take effect. 

• Check the SmartLink website regularly for SmartWatch XP for the latest available updates: 
www.smartlink.com.au. 
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2.2.4 Windows XP Service Pack 2 – Firewall Setup for SmartWatch XP 
 

▲ WARNING: If the Windows XP operating system is running Service Pack 2 then follow the 
instructions below to setup the firewall options. If the firewall options are not set the 
SmartWatch XP clients will not be able to access the SmartWatch XP server. 

 

Either go to Control Panel | Security Centre | Windows Firewall | Exceptions, or locate the 
network connection for your Local Area Network (LAN) by going through to Control Panel | Network 
Connections to find this. 

 

 
 

Select properties for the LAN connection, then select the Advanced tab and press the Settings 
button. 
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Adding SmartWatch XP Server 
 

In the Exceptions tab, click Add Program. 
 

 
 

Browse for SmartWatch XP and click OK. This is normally located in  

C:\Program Files\SmartLink\SmartWatch XP\Client\SmartWatchXP.exe 

 

 



Installation & Service Manual  SmartWatch XP 

Page 14  © SmartLink 

Select OK to save these changes. 

 

SmartWatch XP Clients should now be able to access the SmartWatch XP Server. 
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2.3 Multi Port Serial Cards 
Most computers provide two serial ports, which are traditionally referred to as COM1 and COM2. 

SmartWatch XP relies on serial connections for many of its advanced features.  If you are going to 
be using more than the 1 or 2 serial ports provided with most PC’s then you will need an 8-port serial 
card installed in the PC. 

Each of the following requires a separate serial port: 

• Security Device (dongle) 

• Serial Interfaces 

 
 

A SmartWatch XP system with a multi port serial card supplied by SmartLink will include the 
following components: 

• An 8-port PCI multi-port serial card 

• Octopus cable with 8 serial outlet ports 

The installation of PCI cards varies according to the version of Windows you are running.  Refer to 
the following installation instructions that are appropriate to your situation. 

 IMPORTANT: Technical support is only provided for multi-port serial cards supplied by 
SmartLink. 



Installation & Service Manual  SmartWatch XP 

Page 16  © SmartLink 

2.3.1 PCI Serial Card Installation with Windows XP 
Turn off the computer and insert the card in a spare PCI slot. 

Ensure the SmartWatch XP Installation CD is in the CD ROM drive. 

Start Windows and login as an administrator.  The PCI card is automatically detected. 

Windows will detect the new card and initialize the Found New Hardware Wizard. 

 
 

Select Install the software automatically (Recommended) and Click [Next] to get the Wizard to 
search for new drivers. 
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The Wizard will then search for drivers for the PCCOM PCI 8 Port card. 

 
 

The Wizard should find drivers SmartWatch XP Installation CD is in the CD ROM drive. 

 
 

Select the drivers for the location d:\drivers\serial\winxp\pcicard.inf and Click [Next]. 
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The Wizard will warn you that the drivers have not been verified by Microsoft. 

 
 

Click [Continue Anyway] to proceed with the installation. 

The Found New Hardware Wizard will then proceed to install the new drivers for the PCI card. 
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Click [Finish] once the installation of the Decision PCCOM PCI 8 Port card is complete. 

Windows XP will then proceed to find the 8 new individual Decision PCCOM serial ports. 

 
 

Select Install the software automatically (Recommended) and Click [Next] to get the Wizard to 
search for new drivers. 
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The Found New Hardware Wizard will then proceed to install the new drivers for each of the 8 port 
cards. 

 IMPORTANT: The individual port installation process will repeat a total of 8 times, each 
with it’s own separate Found New Hardware Wizard window. 

 

2.3.2 PCI Serial Card Installation with Windows 2000 
Turn off the computer and insert the card in a spare PCI slot. 

Start Windows and login as an administrator.  The PCI card is automatically detected. 

Windows will detect the new card and initialize the Add New Hardware Wizard but will be unable to 
find the driver.  Click [Next] to get the Add New Hardware Wizard to search for new drivers. 

Select Specify a location then click [Browse] to manually specify the folder Drivers\Serial\Win2000 
on the SmartWatch XP Installation CD, and then click [Next]. 

The installation procedure is similar to that of Windows XP. Simply follow the prompts to continue the 
driver installation. 

 

2.3.3 PCI Serial Card Installation with Windows NT 
Make sure that your version of Windows NT has Service Pack 4 or higher installed. Refer to 
‘Appendix B: Service Packs’ if you need to install a new Service Pack or if you are unsure what 
service pack you currently have installed. 

Turn off the computer and insert the card in a spare PCI slot. 

Start Windows and login as an administrator.  Windows does not detect the card. 
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Run the PCCOM set up program from the Drivers\Serial\NT folder on the SmartWatch XP 
Installation CD.  The set up program will initialize and display the Welcome screen shown below.  
Click [Next] to continue. 

 
 

Click [Finish] to accept the driver. 

 
 

Click [Next] to continue. 

Make sure there is a tick in the Launch the PCCOM configuration utility and click [Finish].  If you do 
not run the PCCOM configuration utility now then you can do so later by running the Decision 
PCCOM Adapters item under the control panel. 
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The PCCOM configuration utility will automatically detect your plug and play PCI multi port serial 
card (see the list of installed devices in the screen below).  Click [OK] to accept the settings.  Done! 
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3 SERVER INSTALLATION AND SETUP 

3.1 Installing the Server 
Once you have installed all the hardware required for SmartWatch XP then you are ready to 
commence software installation. 

Make sure that no other programs are running. 

Place the SmartWatch XP Installation CD in the CD-ROM drive.  The auto-run screen should 
startup automatically. 

To begin installation of the server, click the [Client & Server] button. 

 NOTE: If the auto-run screen does not startup, browse the contents of the cd rom drive 
containing the SmartWatch XP Installation CD, using Windows Explorer or My Computer 
and double click autorun.exe. 
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The installation process will then begin. The following screen is displayed after setup initializes. 

 
 

Click [Next] to display the software license agreement.  Read the license agreement and signal your 
agreement to these terms by clicking [Yes]. 

 NOTE:  The terms of the SmartWatch XP license agreement are also stated at the end of 
this document. 
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The readme file is then displayed which contains important information relating to installing and using 
SmartWatch XP. Read the text on this screen and then click [Next] to continue with the installation. 
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The next screen asks for information such as a username and company name for the current 
machine. Enter this information and then click [Next]. 
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The next screen asks for a license key. Enter the license key into the field on this screen or browse 
to the location of a license key file by clicking [Browse]. Once you have entered in the details, click 
[Next] to proceed. You can use SmartWatch XP in demonstration mode by leaving the license key 
field blank and clicking [Next]. 

 
 

The next screen asks where setup should install SmartWatch XP. Click browse to choose a different 
location if needed. It is recommended that you use the default location. Click [Next] once you are 
satisfied with the install location. Setup will then begin copying files. 
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After setup has finished copying files, you may or may not be asked to restart the computer. If so, 
select “Yes, I want to restart my computer now” and then click [Finish]. Once the computer has 
restarted (if need be), the installation will be complete. 

You will now be able to logon to the server. A shortcut to the client is placed on the desktop and 
start-menu named Client. Double click this icon to start the client. 

The default name that you should enter is maint. Leave the password field blank. You will also need 
to enter the IP address or DNS name of the server in the Server field. Click [Log in] to login to the 
server. 

 NOTE: If you are running a SmartWatch XP client on the server then you may specify the 
server as being either ‘localhost’ or enter the IP of your server. 
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A successful log in will display the Main Screen for the client program as shown below. The 
communication ports and gateways for the server and the contact database may now be configured. 
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3.2 Running the Server 
There are 3 components to SmartWatch XP: 

• MSDE database server 

• SmartWatch XP server 

• SmartWatch XP client 

Taskbar Status Indicators 

The MSDE and SmartWatch XP servers will both run automatically when you start Windows. A task 
bar icon (in the bottom right hand corner of your screen) is available to indicate the status of the 
server as shown below. This icon is displayed by clicking the Server Status icon on the desktop or 
Start Menu. 

 
 

If you are unable to run a SmartWatch XP client then it is likely to be because either the MSDE or the 
SmartWatch XP server is not operating correctly. 
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4 CLIENT INSTALLATION AND SETUP 
If you are running SmartWatch XP on a network then you should install the client software on each 
machine from which you wish to send messages. There are two methods of doing so: 

• Across the network (recommended) 

• From the SmartWatch XP Installation CD 

 IMPORTANT:  The SmartWatch XP server and client applications communicate over a 
network using the TCP/IP protocol.  Your network administrator will be able to tell you 
whether your network supports TCP/IP (you can investigate the configuration of your 
LAN by right clicking on the Network Neighborhood or Network Neighborhood icon on 
your desktop and selecting Properties). If you know that your network supports TCP/IP 
and you can see the server machine by browsing the network neighborhood on the client 
then you should be able to setup a SmartWatch XP server/client network. 

4.1 Installing the Client across the Network 
Once you have installed the Server application it is best to install client applications directly across 
the network. You should contact your LAN system administrator to facilitate the network installation. 

On the server machine, share the folder that contains the setup.exe file to allow read access to other 
machines on the network. This folder is installed to the C:\Program Files\SmartLink\SmartWatch 
XP\Client folder on the server by default. 

From the client machines, browse the shared folder on the server machine using the Network 
Neighborhood icon on the desktop and then run setup.exe. 

This method of client installation will automatically set up the client to communicate with the server 
so that it is ready to run SmartWatch XP. 

If you have already set up the hardware and configured the ports, gateways and contact databases 
for SmartWatch XP then you should be able to send test messages from the client machines. 

4.2 Installing the Client from CD 
It is possible to install client applications directly from the installation CD – though it is not advised.  
Installing the client across the network achieves the same results, without the need to manually 
configure the connection. 

▲ WARNING:  If you choose to install the SmartWatch XP client software using this method 
then you must have sufficient knowledge of your network architecture to manually 
connect the client with the server. 
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If you wish to proceed to install client applications directly from the installation CD, follow these 
steps: 

• Place the SmartWatch XP Installation CD in the CD-ROM drive. The auto-run screen 
should be launched automatically, and the following screen displayed: 

 
 

 NOTE: If the auto-run screen does not start, browse the contents of the CD ROM drive 
containing the SmartWatch XP Installation CD using Windows Explorer or My Computer 
and double click autorun.exe. 

 

• Click the [Client software] button to begin installation. 

• Click [Next] at the ensuing prompts to accept the default installation parameters. 
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• You will then be notified when setup is complete. The screen shown below will be 
displayed. Click [Finish] to complete installation. 

 
 

A shortcut to the client is placed on the desktop and start-menu named Client. Double click this icon 
to start the client software. A login screen will be shown as below. 

 
 

You will need to enter the IP address or DNS name of the server in the Server field as well as the 
login details. Click [Log in] to login to the server. 

 NOTE: If you are running a SmartWatch XP client on the server then you may specify the 
server as being either ‘localhost’ or enter the IP of your server. 
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Server Name 

If you install the SmartWatch XP client across the network using the setup.exe program, then the 
client login will have automatically detected the server name and port.  When you attempt to login 
across the network you should not modify the data in the Server field of the login screen. 

If the server name is wrong then you will receive the following error message: 

 
 

Server TCP/IP Port 

The SmartWatch XP server normally listens on port 5100 for connections from the client software. 
Most configurations of Windows systems leave port 5100 available, but in some situations this port is 
used by other applications. 

If you are installing client software and are unable to login to the server then it may be possible that 
the port you are trying to access is not available for SmartWatch XP communications. If this is the 
case, an error message will be displayed suggesting you should check that the SmartWatch XP 
server is running, that your network is functioning and that you are able to browse the network 
neighbourhood. If the problem persists then you should attempt to establish a connection on another 
port. 

Click the Settings button on the main screen, select the Server Options tab and enter an alternative 
TCP/IP connection port between 1024 and 65534. 
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This example shows port 5100 being used. After entering a new connection port you must click save, 
exit the client, restart the server and then login to the client with the new port settings. 

 
 

You will be able to login using the same name and password as previously, but you MUST add the 
server port number to the server name in the Server field on the login screen.  The example above 
demonstrates how devserver:5100 specifies a server called devserver listening on port 5100 by 
separating the server name and port by a colon. 

 
 

You will have to make the same change on any clients that you have already installed. Every 
client remembers the server name and port to which it last connected so you only have to make the 
change once. Further, any future clients installed using the setup.exe program will automatically be 
configured with the correct server name and port settings. 

 NOTE: You will not have to change the TCP/IP connection port on most SmartWatch XP 
systems. 
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5 SMARTWATCH XP CONFIGURATION 
Configuration for some of the most common interfaces is outlined in the sections below. 

For more detailed configuration of SmartWatch XP, see the SmartWatch XP Online Help by pressing 
[F1] at any time in the software. 

 

5.1 Transmitters 
SmartWatch XP provides the ability to send messages to local area pagers using a POCSAG 
transmitter.  Messages are sent from a serial port, through a POCSAG encoder and then onto the 
transmitter.  Multiple transmitters may be used if care is taken to avoid overlap of concurrent signals. 

Most transmitters create a significant power drain on the serial data connection to the PC.  When 
possible you should use shielded cable such as CAT5, especially if the transmitter is not situated 
near the PC. Do not connect other devices (except SmartLink approved line drivers to boost the 
signal) between the PC and the transmitter.  Devices such as line activity monitors with LED displays 
or lights should NOT be used because the power needed to activate the LED display will draw too 
much current and weaken the signal to the transmitter. 

Further, you should ensure that the transmitter is not located within 3 meters of any electronics 
equipment to prevent interference. 

If you are not using a POCSAG transmitter supported by SmartLink then you will have to obtain 
details of the pin outs for the transmitter and match them to the serial port on SmartWatch XP. The 
pins for some common transmitters are outlined in the table below. 
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PTT 20 4 3 3 5 6 3 3 
POCSAG Data 4 7 5 5 13 1 2 9 
Transmit Inhibit 5 8  9 - 13 - 6 
Ground 7 5 7 6 1 9 5 4 

 

5.1.1 Components 
A SmartWatch XP system with a transmitter supplied by SmartLink will include the following 
components: 

• A POCSAG encoder/security device (dongle) 

• A transmitter connector set 

• Transmitter 

• Power supply 
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In addition to these items you will also require: 

• One spare serial port for each transmitter on the SmartWatch XP server PC. 

• RJ45 cable of sufficient length to connect the server PC to the transmitter. 

You may also require the following: 

• Line drivers if the distance between the transmitter and SmartWatch XP server PC is too 
long. 

• A multi-port serial card if the SmartWatch XP server PC has no free serial ports left. 

  
 

5.1.2 Hardware Installation 
Every SmartWatch XP that is licensed to more than one user includes at least one Dongle that 
serves as a security device. The dongle acts as a security device to prevent unauthorized distribution 
of multi-user SmartWatch XP. You need to successfully install the security device in order to 
configure Gateways and send messages. 

 
 

Dongle Installation Steps 
• Attach the female end of the device to a spare serial port on the server PC (if you are 

currently running SmartWatch XP then you must restart the program to detect the security 
device). 

• You may attach the device to a spare DB9 serial port on your PC if you have a DB9F to 
DB25M converter. 

 IMPORTANT: The female end (with holes) connects to the PC end. 
• Take note of the COM port number the dongle is connected to as this information will be 

required during software setup. This information is usually written next to the actual com 
port on the rear panel of the PC. 

▲ WARNING: The security device is a serial Dongle. Do not put the Dongle on the printer 
port because this will damage the Dongle. 
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Transmitter Hardware Installation 

To install a transmitter, follow these steps: 

• Find a spare POCSAG encoder/security device on the server PC (installed previously). 

• The transmitter connector set consists of two connectors; one connects to the POCSAG 
encoder, the other to the data port on the transmitter. 

• Run RJ45 cable between the two connector set components. 

• Connect the antenna to the BNC/PL259 port on the transmitter. 

• Plug in the power supply to the transmitter. 

▲ WARNING: Do NOT locate the transmitter within 3 meters of any electronics equipment 
(interference may occur if the transmitter is too close to the electronics).  This includes 
other SmartLink equipment. 

5.1.3 Setting up the Port 
To configure a port for the transmitter to use select Interfaces > Ports from the Main Screen. 

 
 

Click New to create a new Port. 

In the Name field type a name to describe the transmitter being connected. 

In the Protocol field select Pocsag from the drop down list. 

In the Type field choose Direct RS-232. 

In the Serial Port field select the COM port that the transmitter is connected to. 

 NOTE: This COM port number is usually written next to the COM port connector on the 
back of the PC or on the multi port serial card cables. 

In the Flow Control field choose RTS/CTS. 

Click Save > Close when finished to return to the Main Screen. 
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5.1.4 Setting up the Gateway 
To configure a gateway for the transmitter select Interfaces > Pocsag from the Main Screen. 

 
 

Click the name of the Port on the left side of the window. The details for the transmitter will then 
show up on the right side. 

The Pocsag speed drop down menu refers to the baud rate of the transmissions. This speed must 
match that of any pagers being used at the site. 

The Power up time field refers to the time in milliseconds that the Push To Talk (PTT) signal will be 
asserted before data modulation begins. This parameter can normally be left as default, but may 
need to be set to meet the timing requirements of your POCSAG transmitter. 

The Power down time refers to the time in milliseconds that the PTT signal remains asserted after 
the completion of data modulation. It should normally be left as default. 

The Sync Time field refers to the number of POCSAG batches that may be sent without 
retransmitting preamble for resynchronization of pagers. It should be left at the default setting unless 
otherwise instructed. 

The Messages per sync field is the maximum number of messages that are sent without 
retransmitting preamble for resynchronization of pagers. If you are having problems with message 
corruption then trying low values e.g. 1, 2 or 3 may fix some issues. 

The Contains security device tick-box should be checked for exactly one POCSAG Gateway on the 
system; the Gateway containing the dongle that will act as the security device. If you attempt to 
enable this setting for more than one POCSAG Gateway, an error will be presented. 

The Exclusive tick-box will cause this POCSAG Gateway to transmit only when no other POCSAG 
Gateways are transmitting. Use this setting for POCSAG transmitters on the same frequency with 
overlapping coverage areas to avoid RF interference problems. If this option is not set, the Gateway 
will transmit simultaneously with all other Gateways that do not have the Exclusive option enabled. 
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The next set of tick-boxes, refer to advanced transmitter properties. You can click the Presets button 
to choose from a selection of some common transmitters. 

 
Field  
PTT Invert Will change the polarity of the Push To Talk output signal to suit certain transmitters when 

checked. 
Data Invert Will change the polarity of the Data output signal to suit certain transmitters when checked. 
Ignore 
Busy 

Will disregard any channel busy signal from the transmitter. If the POCSAG transmitter 
supports a Channel Busy signal, this option should not be set, in order to ensure that 
SmartWatch XP it only transmits when there is no other traffic on the radio channel. 

Busy Invert Will change the way the polarity of the Busy input signal is interpreted to suit certain 
transmitters when checked. 

 

The Transmitter test tick-box will cause the output data signal to oscillate at the POCSAG speed. 
This setting is used for testing only, and should not be used in normal operation as it causes the 
transmitter to heat up when used for prolonged periods of time. 

The Max Msg Length text box refers to the longest message that can be sent through POCSAG 
Gateways. Messages longer than this will either be truncated or split, depending on the setting. This 
setting affects all POCSAG Gateways. 

The Threshold field sets the size of the outgoing message queue threshold. 

The Split long messages tick-box will cause messages longer than the maximum message length 
setting to be sent as separate sequential messages for all POCSAG Gateways. 

The Ports enabled will allow POCSAG transmissions through all POCSAG Gateways when checked. 
It should be enabled for normal operation. 
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5.1.5 Setting up a Contact 
To setup a contact that will receive POCSAG messages from a transmitter follow the directions 
below. 

Right mouse click in the Recipients window within the SmartWatch XP Main Screen and select New 
Contact. 

The screen shown below will be displayed. 

 
 

In the Name field enter a name to describe the contact. 

In the Address field enter the cap code that the message will be sent out on, to the receiving device. 

From the Send via drop down menu choose Pocsag Gateway. 

In the Receiver type drop down menu choose the type of pager the messages will be sent to. These 
are outlines below. 

 
Option  
Tone only No text may be sent to this contact. 
Numeric page Only digits and some limited punctuation characters may be sent. 
Alpha page Full text messaging is supported by this contact. 

 

Click Save > Close when ready to return to the Main Screen. 
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5.1.6 Testing and Troubleshooting 
To attempt to send a message to the recipient, from the Main Screen click the contact in the 
Recipient window, type a message in the Message to send window and click the Send button. 

Should you experience difficulties with your transmitter, the following section identifies some of the 
issues and outlines some tips for resolving these issues. 

Thick steel and concrete, large magnetic and electric fields, and terrain and weather conditions will 
affect transmitter efficiency, so you will need to test the coverage of your local area transmitter at 
some stage of installation. 

When you perform the test you should pay particular attention to the quality of the messages that 
you receive on the test pager.  If you receive corrupted messages then it is possible that you will 
have problems sending messages to that region. 

If you find that you are receiving corrupted messages then you should consider the following 
methods for improving transmission quality: 

• Move the antenna to a position that gives it a clear line of site to all areas you wish to cover. 

• Reduce the length of the cable connecting the aerial to transmitter. 

• Use the appropriate coaxial cable to connect the aerial to transmitter which will suit the 
length of the cable run. For example use RG213 for runs up to 20 meters and use LDF440 
for runs over 20 meters. 

• Choose another type of antenna for the transmitter. 

• Position the antenna in a higher location. 

If you find that you cannot send a message to an on site pager at all then you should check the 
following: 

• Check that you have configured the transmitter correctly in SmartWatch XP. E.g.: PT500 
transmitter use an inverted data signal, most other transmitter use a normal signal. Most 
POCSAG transmitters communicate at 512bps. 

• Check that you are using the correct transmitter connector set, and that the connections are 
tight. 

• If your transmitter has a Busy light then check that it is not on, this may indicate that another 
transmitter in the area is flooding the frequency on which you are trying to transmit. 

• Check that you have the POCSAG transmitter port with the pager in the contacts database 
in SmartWatch XP. 

 

Coverage of Areas with Poor Reception 

Dependant on the size and situation of the problem areas there are a number of practical solutions. 

• Have the cable between transmitter and aerial as short as possible. 

• Raising the Aerial can increase the range of the transmitter doubling the height increases 
the free field range by a factor of 1: 41 (square root). 

 

The Installation of Multiple Transmitters and Aerials 

For buildings in an area with good field strength outside but weak reception within, possibly caused 
by shielding due to reinforcement in suspended slabs, metal plating and other building materials: 

• The supply lead to the aerial can serve as a radiator, effectively providing a 5 meter (yard) 
range form the cable. 

• The supply from open (leaky) coaxial cable as a line radiator lead to a 50 Ω terminator (the 
cable is in effect the aerial). 
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VHF/UHF Transmitter and Aerial Installation Methods 

Increasing the Transmitter Power: There are a number of objections to this method, such as local 
restrictions on aerial power. In addition, doubling the transmitter power to the aerial only gives an 
increase in range of a factor of 1:19 (fourth root). 

Increasing the Aerial Height or Using an Aerial with a Gain in Certain Directions: These methods 
may also be limited by local regulations. 

 

Raising the Aerial 

Ensure allowance is made for a properly tuned antenna, base, building entry sealing boot, correct 
coaxial cable and connectors. 
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5.2 SmartLink Receivers 
5.2.1 Setting up the Port 

The SmartLink Receiver Port can handle Ademco "High Speed" and "Contact ID" formats for a 
variety of SmartLink products and systems including SmartLink Medi-Call Dialler Units. 

This SmartLink Receiver Port allows receipt of information from these diallers and other systems 
where on it is automatically linked to Clients and passed to the Pending Calls screen. 

 
 

In the Name field enter a name to describe the SmartLink Receiver port. 

In the Protocol field select SmartLink Receiver. (You will see the configuration fields appear to reflect 
the example above). 

If you are intending to receive SmartLink Medi-Call dialer alarms via a MCU modem select Rockwell 
Modem  or if you intend to use a SCU Receiver (Linecard) then choose Direct RS-232. For other 
SmartLink system such as SmartWire or SmartLine choose Direct RS-232. 

 IMPORTANT:  Choosing Direct RS-232 as the Type ensures that the port will be polled to 
monitor for activity. In the event a SmartLink Receiver is disconnected or fails, a 
message will automatically be generated to the Maintenance Recipient indicating the 
fault. The (MCU) Rockwell Modem does not use Polling and therefore can not guarantee 
that alarms are being received. 

In the Serial Port field select the COM port that the transmitter is connected to. 

Leave the Flow Control field to None 

Click Save > Close when finished to return to the Main Screen. 

 NOTE: When the SmartLink Receiver port is configured, the default gateway 
configuration is automatically enabled. 
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5.2.2 Port Configuration 
Further Port configuration such as baud rate, data bits, parity and stop bits may be adjusted via the 
SmartLink Receiver Serial Ports screen.  This screen is accessed via the menu item Interfaces > 
SmartLink Receiver > Ports. Settings may vary depending on which SmartLink System you plan to 
connect to SmartWatch XP as defined below: 

SCU Receiver 

For connecting a single SCU Receiver directly using RS-232 serial communications: 

 
 

SmartLine Wireless 

For connecting a single SmartLine Master Interface directly using RS-232 serial communications: 

 
 

SmartWire Hard-Wired Nurse Call 

For connecting a single SmartLine Wireless Interface directly using RS-232 serial communications: 
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5.2.3 Testing and Troubleshooting 
SmartLink Receiver Polling 

When a SmartLink Receiver port is set to Direct RS-232 and is communicating correctly, it will 
respond to polling from SmartWatch XP with an ACK (acknowledgement). This can be seen via the 
Port Communications Monitor screen found under Interfaces > Port Communications. 

In the example below a SmartLine Wireless system is responding to all polls or ENQ (enquiries) 
specific to it’s address. 

 
 

 IMPORTANT: The port communications monitor in SmartWatch XP provides a 
method of viewing serial communications for all port interfaces in real time. More 
than one window for different ports can be open at one time making this feature 
particularly useful for diagnosing faults with communications, as well as 
assisting in configuration of the protocol interfaces and port gateways. 

Ademco Alarm Strings 

When an alarm is received at the SmartLink Receiver port you should see a <STX> start character 
followed by the 13 digit Ademco String and ending with a <ETX> end character. 

The 13 digits that make up the Alarm String consist of: 

• 4 digits for the Client Code 

• 8 digits Zone/Channel alarm data 

• 1 digit for Alarm Type Identifier 

• 1 digit for the Checksum 

 NOTE: Consult the Ademco Protocol for more information on understanding the 
workings of Ademco codes. 
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5.2.4 SmartLink Call Types 
Call Types are used to organise Contact ID alarm types and define how SmartLink Alarms/Calls are 
displayed on the SmartLink Alarm Calls screen. 

To configure Call Types, select Edit > SmartLink Call Types from the main menu. The following 
window will be displayed: 

 
 

 NOTE: Default Call Types are already specified during installation according to 
the most common application of SmartLink products. 
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Adding Call Types 

To add a new call type, simply click the [New] button. 

Enter a Name to describe the call type. 

Then choose the colour that this call type will be displayed with by clicking on the Colour box. 

Choose the Colour to be displayed on the SmartLink Alarm screen when an alarm of this type is 
active. If you wish to choose a colour that is not shown, click the Define Custom Colours button to 
extend the window as shown: 

 
 

This extended window allows you to choose the colour graphically, or enter the RGB or HSL values 
directly. When the desired colour has been selected, click the Add to Custom Colours button, select 
the new custom colour, and click the OK button. Clicking on Save will commit the new call type to the 
database. 

Select a Message tone if you wish to override pager tones for that particular call type. 

Enter a level of Priority from 1 (highest) to 99 (lowest). The highest priority call type will have it’s 
Alarm Sound File played in a loop when the SmartLink Alarm Calls window is active. 

Choose an Alarm Sound File from the default install set that will be used as an audible indicator on 
the SmartLink Alarm Calls window when the active call type is of the highest priority. Alternatively 
you can select your own .wav file by Select a tone from the list or alternatively add your own .wav file 
to the ..\Program Files\SmartLink\SmartWatch XP\Client directory on the Client computer and select 
it from the list. 

If you don’t want alarm restorals, cancellations and reset messages sent for a particular call types 
then un-check the Send Resets check box. 

Check the Maintenance check box to define the Call Type as a system alarm that will be sent to the 
Maintenance recipient defined under the Edit > SmartLink Clients window. 
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Editing Call Types 

To edit an existing call type, select the Call Type and modify the options you want changed. 

Clicking Save will commit these changes. If the call types screen is closed before a changed record 
has been saved, the following warning will appear, giving you the choice to save the changes, 
discard the changes, or return to call type editing: 

 
 

It is not possible to have a blank call type. If you try to save a nameless call type, the following 
message will appear: 
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5.2.5 Contact ID 
The Contact ID screen is used to map textual descriptions to Event Codes.  When a system event 
occurs the event code is used to lookup the alarm meaning and alarm event text, which can then be 
used for sending messages or displaying the alarm details.  This screen may be accessed using the 
Interfaces > SmartLink Receiver > Contact ID menu option. 

 
 

 NOTE: The # character indicates that when an alarm is activated, the alarm information 
reported will also include the zone number. For example the settings for Event Code 100 
above will generate the following text "EMERGENCY #2", which indicates that the alarm 
originated from Zone 2. 

Adding Alarm Contact IDs 

To add a new Alarm Contact ID, simply click [New] and enter the required parameters. 

Enter a new Event Code to be used as a unique number used to identify the event. 

Enter an Alarm Meaning and an Alarm Meaning. These will be used in combination with the Alarm 
Event text to create an alarm string. 

Clicking [Save] will commit the details to the database. 

Editing Alarm Contact IDs 

To edit an existing Alarm Contact ID, select the Event Code from the panel on the left, change the 
required parameters on the right, and click [Save] to commit the changes to the database. 

Deleting Alarm Contact IDs 

To delete an existing Alarm Contact ID, select the gateway from the panel on the left, and click 
Delete to remove it. Alternatively, you can select it from the list and press the Delete button on the 
keyboard. It will ask for confirmation before removing the gateway: 
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5.2.6 SmartLink Clients 
Clients in SmartWatch XP are records describing customer or sites for whom SmartLink devices 
such as Medi-Call Dialler Units, SmartWire and SmartLine Call Points etc. are installed and 
registered with SmartWatch XP. The alarm information will come in through the ports configured as 
SmartLink Receivers. 

A single screen is provided to work with Clients: 

 
 

Adding SmartLink Clients 

 IMPORTANT: The Name and Code fields are the minimum required to add a SmartLink 
Client. Each Client must have a unique code between 0001 to 9999. Some Codes are fixed 
in to various other SmartLink products and Systems. If you are unsure which codes are 
available, simply increment starting from 0001 and consult your hardware manuals for 
further details. 

To add a new SmartLink Client, simply click [New]. 

Enter a Name to appear on the main Clients list and on the client alarms screen. 

Enter a Client Code as the unique four digit identifier for the selected client. 

Enter the Phone number for the location if applicable. Leave this field blank for systems that do not 
require a Phone number. 

Enter the Address for the location if applicable. Leave this field blank for systems that do not require 
an Address. 

Choose a Recipient to which messages regarding call activations and cancels will be sent. 

Choose a Maintenance recipient to which system and maintenance messages (see SmartLink Call 
types) are sent. 
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Check the Expect Check-in box and enter a period in days if the client equipment is required to call 
in within the specified period (primarily for Medi-Call dialler units). 

Use Notes to annotate pertinent facts regarding this Client. 

Enter a description for each of the Zone fields. Zone (or Channel) names should match the actual 
SmartLink Devices. For example, Medi-Call dialers can handle up to 8 separate wireless devices 
which can be programmed to report on each of the available zones. 

 NOTE: The Medi-Call Unit’s default reporting zone for the unit button (red) is Channel 6. 
Consult the Medi-Call Installation Manual as to how this can be modified for particular 
applications. 

Contact details can be added under Contacts, including Name, Relationship and two contact Phone 
numbers in the event of an emergency. 

Editing SmartLink Clients 

To edit an existing SmartLink Client, select the Name/Code from the panel on the left, change the 
required parameters on the right, and click [Save] to commit the changes to the database. 

Deleting SmartLink Clients 

To delete an existing SmartLink Client, select the gateway from the panel on the left, and click Delete 
to remove it. Alternatively, you can select it from the list and press the Delete button on the 
keyboard. It will ask for confirmation before removing the gateway: 
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5.2.7 Client Call Manager 
The Client Call Manager window allows the modification of behaviour specific to SmartLink alarm call 
messaging. The Client call manager is part of the server that is responsible for keeping track of 
external clients and for generating and processing alarms. The client call manager settings may be 
modified by selecting the Interfaces > Client Call Manager menu option. 

 
 

Enter a time for the Ensure clients have checked in each day at field. This refers to the time in hours 
and minutes in which the server will examine client check-in times. If clients have not checked in as 
expected then an alarm will be raised. When you change the value for the time the client check-ins 
will only be checked when that time is reached. In the above example, the system will check at 11:05 
in the morning each day that clients have checked in within the time specified in the Clients screen. 

 NOTE:  When the server is started all clients will be checked according to the expected 
check-in time as specified in the Clients screen. 

Select which items of the outgoing SmartLink alarm message that you wish to exclude or include 
under the Message Settings. In the above example, any client alarms that are generated will be 
composed of Name, Phone, Address, Alarm Meaning, Alarm Event and Zone Description. 

The format of the actual message sent will be dependant on the content of the selected message 
items defined under Edit > SmartLink Clients. 

The order of the message content can also be modified by selecting the item in the list and using the 
arrows to the right of the window to move the item up or down in the list order. Items at the top will be 
at the start of the message. 

 IMPORTANT: The Alarm Meaning and Alarm Event can only be modified globally for a 
under Interfaces > SmartLink Ports > Contact ID. All other message/alarm items can be 
modified on an individual basis using Edit > SmartLink Clients. 
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5.3 Viewing SmartLink Alarms 
5.3.1 SmartLink Alarm Calls 

Active SmartLink Alarm Calls can be viewed by selecting View > SmartLink Alarm Calls or by 
pressing the Alarms button on the Main Messaging screen. The SmartLink Alarms Calls window also 
allows the processing of active Alarms that have entered via the SmartLink Receiver ports, provided 
the user has processing privileges. 

 
 

The list of SmartLink Alarm Calls may be ordered on any field displayed in ascending or descending 
order by clicking on the name of the field along the top row of the window.  By default, alarms are 
ordered from newest to oldest. The Recipient column shows the recipient that received notification of 
the alarm condition. 

The window size, location, column order etc. will be remembered such that the layout can be 
customised to suit your particular application. 

The Staffed options define that an operator is present at the computer and the SmartLink Alarm Calls 
window will automatically pop-up when a new alarm is activated. The Away option prevents this 
behaviour by keeping the SmartLink Alarm Calls window in it’s current state. 

The Mute button will override any audible alarm sounds applicable to an active alarm with the 
highest priority. To define your own audible alarm sounds see SmartLink Call Types. 

 

Processing Alarms 

To manually process a single alarm at the computer, select the alarm in the SmartLink Alarm Calls 
window then click [Process]. 

The following window will be displayed allowing the operator to enter additional alarm notes: 

 
 

Press [OK] to confirm or Cancel to leave the alarm active in the SmartLink Alarm Calls window. 
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Modifying Alarm Display Settings 

Settings for the SmartLink Alarm Calls Screen can be modified by Clicking Settings. 

 
 

Choose which alarms will be visible, either: 

1. Assigned to me. 

2. Assigned to me and any unassigned. 

3. Assigned to anyone (default). 

 NOTE:  Options 1 and 2 are typically suitable for Call Centre applications and option 3 
will ensure ALL active alarms are displayed making it most suitable for Nurse Call 
applications. 

Select the Text Size. Normal is for displaying larger amounts of information where as Large is used 
to increase visibility in Nurse Call applications. 

 
 

 IMPORTANT: When using the Large Text Size it is recommended that the SmartLink 
Alarm Calls window is adjusted to include only a few columns of fixed width to ensure 
only the  relevant information is included whilst allowing it to be easily identified. 
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5.3.2 Client Call Details 
The client call details can be viewed by double clicking on an active alarm in the SmartLink Alarm 
Calls window. Below you can see the summary information regarding the example alarm for Mrs 
Brown: 

 
 

Normally an alarm should be cancelled at its physical origin however if necessary the alarm can 
alternatively be processed with the option to leave recorded Alarm notes. 
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5.3.3 Test Alarms 
The Test Alarm screen allows you to generate Contact ID or High Speed format alarms. You can 
change between Contact ID or Ademco High Speed by selecting the Method drop down list. 

 
 

Enter a Client Code: 

Select the Method as either Ademco High Speed or Contact ID. 

Select which Zone Alarms you wish to generate alarms for. 

 NOTE:  Generally a 1 - New Alarm will activate most Alarm Events and a 3 - Zone Alarm 
restores Alarm Events. For further details on the High Speed method consult the Ademco 
Protocol for details on possible combinations of Alarm Event and Zone Alarm types. 
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5.3.4 Configure Test Alarms 
The Configure Test Alarms window can be accessed by clicking [Configure] on the Test Alarm 
window and allows you to customise the look of the Test Alarms. 

 
 

In order to modify an item, first select the item that you want to change, type in the associated edit 
box and then Click [save]. 
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5.4 The PBX Interface 
SmartWatch XP uses modems for PBX messaging. 

 

5.4.1 Components 
A SmartWatch XP system with the PBX interface supplied by SmartLink will include the following 
components: 

• Modem (one per PBX phone line required). 

• A serial modem cable to connect the modem to a PC (one per modem). 

• 2-wire analogue RJ11 telephone cable (one per modem). 

• A suitable power supply (one per modem). 

In addition to these items you will also require: 

• One spare serial port on the SmartWatch XP server PC per PBX modem. 

• One free telephone sockets (one per modem). 

 IMPORTANT:  Two wire analogue extensions are required - digital lines will not work. 

5.4.2 Hardware Installation 
To install a modem for SmartWatch XP, follow these steps: 

With the PC turned off, use the modem cable to connect the modem to a spare serial port on the 
server PC. 

Use the RJ11 cable to connect the line socket on the modem to the telephone socket. 

▲ WARNING: SmartWatch XP will not be able to communicate with the modem if you 
mistakenly connect the RJ11 cable into the “phone” socket of the modem instead of the 
“line” socket. 
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Plug in the power supply and turn the power on. Boot up the PC into Windows. 

 NOTE:  Each PBX line requires a separate modem. Technical inquiries relating to the PBX 
interface are only supported if SmartLink has supplied the modems being used at the 
site. 

 

5.4.3 Setting up the Port 
To configure a port for the modem select Interfaces > Ports from the Main Screen. 

 
Click New to create a new Port. 

In the Name field type a name to describe the modem. 

In the Protocol field select PBX from the drop down list. 

In the Type field choose the type (brand) of modem being connected. 

In the Serial Port field select the COM port that the modem is connected to. 

 NOTE: This COM port number is usually written next to the COM port connector on the 
back of the PC or on the multi port serial card cables. 

In the Flow Control field choose RTS/CTS. 

The Initialization String field may be left blank if a generic modem is being used. If the modem is not 
generic, an initialization string may be required. Consult the modem manual for details. 

The Dial String field may be left blank if a generic modem is being used. If the modem is not generic, 
a special dial string may be required to request the modem to dial a number. Consult the modem 
manual for details. 

The Answer after ___ modem rings field should be a number greater than zero.  If 0 is entered the 
modem will not auto answer. This is how long the server should wait before answering an incoming 
call. 

Click Save > Close when finished to return to the Main Screen. 
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5.4.4 Setting up the Gateway 
To configure a gateway for the PBX modem, select Interfaces > PBX > PBX from the Main Screen. 

 
 

Click the name of the Port on the left side of the window. The details for the PBX interface will then 
show up on the right side. 

The Access PIN field is used to enter an optional four digit access number for users to gain access 
to the PBX line. It is only used only if the following option is enabled. 

When ticked, the Use PIN field will force the Access PIN defined above, to be required. In this case 
the first voice message sent upon call connection will be “Enter PIN Number” If the Access PIN is 
entered correctly, the call will proceed as normal, otherwise the call will be terminated after one PIN 
retry. 

If enabled, the Support priority calls tick box requires callers to add an extra digit after the Pager 
Number. A “1” will make the call a priority call, whereas a 0 will be treated as a normal call. Please 
note that this extra digit is mandatory when this option is enabled – calls will not be initiated if it is not 
used. 

The Limit number of messages field limits the number of messages a user may send during a single 
call. The number of messages is defined below. 

The Maximum of __ messages per call field is the maximum number of messages a user may send 
during a single call if Limit number of messages is set above. 

The Enable escalations tick-box enables or disables the ability to send to escalations, even if the 
escalation is embedded in a group, roster etc. 

The Enable extended functions tick-box enables or disables advanced PBX functions such as 
absence/presence and cancel escalation. This is discussed in more detail below. 

The This port is extension __ on PBX field, is the number of the PBX extension to which this port is 
connected. 

Click Save > Close when finished to return to the Main Screen. 

 

5.4.5 Setting up the PBX messages 
PBX Messages allow alphanumeric messages to be sent via a touchtone telephone connected to the 
PBX. Entering a * followed by a two digit number as part of the message phase of a telephone call 
will invoke the corresponding predefined alphanumeric message. 
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To configure these messages select Interfaces > PBX > PBX Messages from the Main Screen. 

 
 

Click New to create a new message entry. 

In the ID field, enter a number that will correspond to the PBX message text. The maximum length of 
this number is defined in the Edit > Settings > Global tab > No. digits (PBX Messages) field. 

In the Message text field, enter the actual text that will be included in the sent message. 

Click Save > Close to save changes and return to the Main Screen, or New to create another entry. 
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5.4.6 Using PBX Messaging 
The following section outlines how to send messages using the PBX system. 

Normal PBX Messaging 

PBX messaging provides the ability to dispatch messages via telephones capable of sending DTMF 
tones using the following procedure: 

Dial the extension number used by the PBX Interface in SmartWatch XP. 

The PBX Interface will answer your call after a preset number of rings (two by default). 

The PBX Interface will prompt you with Enter PIN or Enter Pager Number or Select Function. In the 
latter situation, skip to step 7. 

Enter the four-digit access PIN using the numbers on your telephone.  This information will be 
available from your SmartWatch XP administrator. 

If the PIN is incorrect, the PBX Interface will revert to Step 2. 

The PBX Interface will prompt you with Enter pager number or Select Function. 

Enter the Local ID of the recipient for this message.  This number will be a preset length configured 
by your SmartWatch XP administrator, and hence may need to be padded with zeros.  For example, 
you should type 003 to contact the recipient with a Local ID of 3 if your system uses three digit Local 
IDs.  You should type 0003 to contact the same recipient in a four digit Local ID configuration. 

You may need to enter an extra digit to set the priority of this message.  Entering a 0 will make the 
message a normal priority, whereas entering 1 will render the message high priority. 

If the Local ID entered is not available in SmartWatch XP, the PBX Interface will respond with Pager 
Not Registered, and revert to Step 6. 

The PBX Interface will prompt you with Enter Message. 

Enter the message you wish to send using the numbers on your telephone.  More information on the 
formation of messages is presented below. 

Press the * key twice to send the message.  The PBX Interface in will respond with Message Sent, 
and revert to step 6.  If you have no more messages to send, simply hang up. 

Example: 
A typical PBX Interface transaction is outlined below: 

• SmartWatch XP: Enter pager number or Select Function 

• User Enters:  003 

• SmartWatch XP: Enter message 

• User Enters:  1234567** 

• SmartWatch XP: Message sent 
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PBX Function Options 

The PBX Interface can be used to execute certain functions as well as for sending messages. These 
functions are mostly concerned with Absence/ Presence and the setting of Diversion and Buddies to 
recipients. 

In order to execute a Function Option, type * and the Function Option digit when prompted for Enter 
Pager Number. 

The Function Options are as follows: 

• Makes the recipient absent. 

• Makes the recipient present. 

• Cancel Escalation. 

• Sets a Diversion. 

• Clears Diversion. 

• UNUSED. 

• Sets a Buddy. 

• Clears Buddy. 

• Self Test - simply sends a test message to the given recipient. 

Example 
As an example of a Function Option, say you want to make pager number 44 absent, and then divert 
it to pager number 55. The procedure for this is as follows: 

• Enter Pager Number or Select Function 

• User Enters: *1 44 

• You are now Absent 

• Enter Pager Number or Select Function 

• User Enters: *4 44 55 

• Diversion Activated 

Now you change your mind, and want to make 44 present again and clear the diversion: 

• Enter Pager Number or Select Function 

• User Enters: *2 44 

• You are now Present 

• Enter Pager Number or Select Function 

• User Enters: *5 44 

• Diversion Cleared 
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 To cancel an escalation: 

• Enter Pager Number or Select Function 

• User Enters: *3 0000000001 

• Message sent 

 

 Sending Alphanumeric Messages 

SmartWatch XP maintains a list of alphanumeric PBX Messages, which can be inserted into 
messages initiated via the PBX Interface. These messages are configured in the Setting up PBX 
Messages section previously. 

To insert a PBX Message, simply press * followed by the two digit number of the PBX Message you 
wish to send. You can insert multiple alphanumeric PBX Messages as part of the message you wish 
to send, and mix and match alphanumeric messages with numeric digits. 

For example, if you have configured message number 01 as Contact Extension Number then you 
would type *01 123 to send the message Contact Extension Number 123.  In this example the *01 
portion of the message specifies the PBX Message to insert into the text, and the 123 specifies the 
extension number to append to the end of the PBX message.  You can combine as many PBX 
messages and numeric characters as you like within a single message, in any order. 
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5.5 AIM Networks 
SmartWatch XP uses Alarm Interface Modules (AIM's) to monitor alarm conditions.  An AIM network 
consists of an AIM controller attached to SmartWatch XP and a number of AIM’s. 

 
 

5.5.1 Components 
A SmartWatch XP system with an AIM network supplied by SmartLink will include the following 
components: 

• One AIM controller and independent power supply per 63 AIM boards. 

• One or more AIM boards, each with an independent power supply. 

In addition to these items you will also require: 

• One spare serial port on the SmartWatch XP server PC per AIM controller. 

• 2-wire cable for AIM data communications. 

•  

AIM Controllers 

This small device interprets data passed between the RS232 style serial ports on a PC and the data 
ports on AIM boards. 

 
 

If you are upgrading an existing SmartWatch XP system that includes an AIM network then you may 
possess an AIM controller card, which you may use in lieu of an external AIM controller.  The 
appendix at the end of this manual describes the installation of AIM controller cards. 

These 2 switches on the face of the AIM controller must 
be configured as shown below.  

The 4-line green block connects the AIM controller to the 
data lines on AIM boards.  

The DB25 serial port connects to the PC.  
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5.5.2 Hardware Installation 
The AIM Network will not work if the two switches on the face of the converter are not in the following 
positions: 

 
 

• The left hand switch must be set to the MIDDLE position to indicate T-RTS/R-RTS. 

• The switch on the right must be in the UP position to select DCE. 

 

Bridge some of the 4 lines of AIM controller data output via the green block at the bottom of the 
converter. The cover of the converter identifies the lines as 1, 2, 3 and 4. Use a short (4cm) strand of 
wire to bridge the lines as follows: 

 
 

• Lines 1 and 4 are bridged. 

• Lines 2 and 3 are bridged. 

 

Attached the DB25 end of the converter to a serial port on the SmartWatch XP server PC. 

Remove the cover of the first AIM board to be used in the network. Identify the blue 8-switch box 
labeled SW1 and the green 5-line block labeled I/O. 

The 8 switches on SW1 allow you to configure the baud rate and ID of the AIM board. Normally you 
will setup AIM boards with a BAUD rate of 9600, for which switches 7 and 8 should be in the ‘ON’ 
position. The first aim on the network has an ID of 1, indicated by setting switch 1 ‘ON’ and pins 2 
through 6 ‘OFF’. 

Two of the five lines on the I/O block are used to connect the AIM board to the AIM controller.  Use 
2-wire cable to connect the line labeled ‘RS485+’ on the AIM to line 1 on the converter, and ´RS485-‘ 
to line 2. 

Connect the power supply to the lines labeled +12V and 0V on the I/O block. The orange power LED 
on the AIM will light. 
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Up to 63 AIM’s can be connected to the same network. 

• You can interconnect AIM’s by wiring RS485+ to RS485+ and RS485- to RS485-. 
Alternatively, multiple AIM’s can be wired directly into the converter in the same manner as 
the first AIM on the network. 

• All AIM’s on the network must be set to the same baud rate. Switches 7 and 8 may be 
adjusted as follows: 

 
Baud Rate Switch 7 Switch 8 
1200 OFF OFF 
2400 ON OFF 
4800 OFF ON 
9600 ON ON 

 
• Each AIM must be given a unique ID. The first AIM on the network has an ID of 1, the 

second 2, and so on. Switches 1 to 6 of SW1 control the ID of an AIM using a binary 
sequence. 

 
AIM ID Switch 1 Switch 2 Switch 3 Switch 4 Switch 5 Switch 6 
1 ON OFF OFF OFF OFF OFF 
2 OFF ON OFF OFF OFF OFF 
3 ON ON OFF OFF OFF OFF 
4 OFF OFF ON OFF OFF OFF 
5 ON OFF ON OFF OFF OFF 
6 OFF ON ON OFF OFF OFF 
7 ON ON ON OFF OFF OFF 
…        
63 ON ON ON ON ON ON 

 
• SmartWatch XP can monitor multiple AIM Networks. Each network requires a separate 

serial port and AIM controller. 

• The SmartWatch XP software must be configured to communicate with the AIM Network. 
Refer to the online help. 
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5.5.3 Setting up the Port 
To configure a port for the AIM’s to use select Interfaces > Ports from the Main Screen. 

 
 

Click New to create a new Port. 

In the Name field type a name to describe the serial port the AIM controller connected to this port. 

In the Protocol field select AIM from the drop down list. 

In the Type field choose Direct RS-485. 

In the Serial Port field select the COM port that the Serial > RS-485 converter is connected to. 
Installation of this converter is discussed previously. 

 NOTE: This COM port number is usually written next to the COM port connector on the 
back of the PC or on the multi port serial card cables. 

In the Flow Control field choose RTS Toggle. If an external Serial > RS-485 converter is present then 
this field can be set to none. 

Click Save > Close when finished to return to the Main Screen. 
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5.5.4 Setting up the Gateway 
To configure a gateway for the AIM’s select Interfaces > AIM > AIM from the Main Screen. 

Click the name of the Port on the left side of the window. This refers to the serial port the AIM 
controller is connected to. The details for the AIM node will then show up on the right side. 

 
 

The Baud field refers to the serial communications speed of the AIM modules attached to this 
gateway. For more information on how to configure the baud rate for the AIM modules, please refer 
to the AIM Installation Manual. 

The Controllers window provides a list of AIM modules that may be connected to the AIM Gateway, 
and their current polling status.  A green tick indicates that polls are being sent to the AIM, whereas a 
red cross indicates that the AIM is not being polled. AIM’s can be enabled and disabled by clicking 
on these icons. 

If unticked, the Pass on undefined messages tick-box alarms for which no alarm input has been 
defined will not be forwarded further into the system. When set, alarm activations and resets for 
which no alarm input have been defined will be passed into the system. 

When ticked, the Inputs on this port default to normally open tick-box, forces the default for all inputs 
which don't have an alarm input defined to normally open. Otherwise they will default to normally 
closed. 
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5.5.5 Setting up Alarm Inputs 
Each alarm input on each AIM module must be setup individually. To configure these inputs select 
Interfaces > AIM > Alarm Inputs from the Main Screen. 

Click New to create a new entry for an alarm input. 

In the Name field, type a name that defines the alarm input. 

 
 

In the Port field choose the serial port setup previously that contains the alarm input you are setting 
up. 

The Device ID field refers to the AIM module number (RS-485 ID) that this alarm input resides 
on. For more information on how to configure Alarm Interface Modules, please refer to the AIM 
Installation Manual. 

Input ID is the actual input number of this alarm on a given AIM, and may be between 1 and 32. For 
more information on AIM input numbering, please refer to the AIM Installation Manual. 

The Recipient field refers to the device or group of devices that should be contacted upon activation 
of this alarm input. 

Initial delay specifies the time that the alarm should remain active before being added to the list of 
active alarms in SmartWatch XP.  This setting is particularly useful for applications like door alarms, 
where short periods of alarm activation are acceptable, but prolonged activation should initiate 
messaging. 

Activation message is the actual text that should be sent to the recipient upon alarm activation. 
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Activation tone refers to the beep code (or function digit) used to send the activation message.  The 
functionality of this setting may depend on the type of gateway through which the message is being 
sent. 

Priority Message determines if the activation message should be treated as a priority message. 

Reset message is the actual text that should be sent to the recipient upon alarm deactivation. 

Enabled determines if this alarm input will cause a message to be initiated upon activation.  It should 
be checked for normal operation. 

Normally closed should be selected if this alarm input presents a short circuit for its inactive state, 
and an open circuit for the active condition. 

Latching will cause the alarm input to remain active in SmartWatch XP after it becomes electrically 
inactive.  The alarm will continue to escalate until it is manually cancelled. 

5.5.6 Testing 
To test an alarm input is working: 

Wire the alarm input up to the switch or device it is going to be monitoring. 

Ensure the SmartWatch XP software is setup properly so that activation occurs correctly. This 
process is outlined previously. 

Activate the alarm input by switching the contact. (turning on a light, opening a door, pressing a 
button etc). 

A message will be dispatched to the recipient specified, as outlined in the Setting Up Alarm Inputs 
section above. 

If no message was received, review all settings in the software to ensure everything is setup 
correctly. 
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6 GLOSSARY 

6.1 Further Help and Support 
 

Online Help 

You can access the SmartWatch XP online help from any client on the network.  You should read the 
Getting Started section of the online help to find out how to install Ports and Gateways for 
Communications once you have installed the hardware and client/server software for SmartWatch 
XP. Online help is accessed by pressing F1 within the software at any time. 

 

Contact your Place of Purchase 

A SmartLink International Authorized Distributor or Dealer sets up most systems. Contact your place 
of purchase with inquiries beyond the scope of this manual. 

 

This Product is Not Field Serviceable 

Should a fault develop with the hardware or software, contact your place of purchase for the most 
appropriate form of action. Do not attempt to open or repair any of the products as this may void any 
warranty. 
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6.2 Glossary 
 

Term Definition 
AIM Alarm Interface Module 
ANSI American National Standards Institute 
Baud The baud rate, the number of data bits and stop bits, and the parity are all properties 

of the data format to be used for the serial port.  You must make sure that you use 
the same settings for these variables on both ends of a serial connection.  The 
Baud rate is the speed at which data is transmitted along the serial connection.  A 
Baud rate of 9600 is common though you may find older devices that use slower 
connections.  Some modems have problems establishing a connection at the lowest 
baud rates.  

Cap Code Seven-digit capacity code number used to identify a pager. See also RIC Number. 
Contact Closure An alarm input that is activated by closing a dry contact. 
LED Light Emitting Diode 
Message Enter the alphanumeric message you wish to send to the selected contact. 

Alphanumeric pagers and mobile phones may receive letters and numbers.  If you 
have selected numeric pagers SmartWatch XP will automatically strip the numeric 
portion of the alphanumeric message to send to these devices. 

Mobile Number Mobile phones with SMS messaging capabilities can receive text messages from 
SmartWatch XP using the mobile phone number. 

Node Nodes in SmartWatch XP represent the method of delivery.  Select the node that will 
be used to send messages that will be sent to the device. 

Opto Coupled An alarm input that is activated by applying a voltage. 
PABX Private Automatic Branch Exchange 
Pager Number Wide area pagers have a pager number that identifies them to the wide area carrier 

that transmits their messages.  As you type in the name of a pager you wish to send a 
message to, SmartWatch XP will search through the pager database to find the pager 
with the name that most closely matches the characters you type.  This means that 
you do not have to type the full pager name. 

PBX The PBX Number is a unique label given to a pager to identify it in the SmartWatch 
XP database. 

PET Pager Entry Terminal (see TAP) 
POCSAG RF Protocol used to communicate to pagers written by the Post Office Code 

Standardization Advisory Group. 
RIC Number The RIC number is programmed into receiver devices such as pagers and identifies 

which transmitted messages are intended for that device.  All pagers have a Cap 
Code that they use to determine which messages are meant for them. 

RS232 Point to Point Serial communications 
RS485 Point to Multipoint Serial Communications 
TAP Telelocator Alphanumeric Protocol. Defined by the PCIA the TAP protocol allows 

messages to be sent between paging systems (typically for city wide paging) 
Depending on your location the TAP protocol is known under different names.  In 
Australia, New Zealand and South East Asia the TAP protocol is generally referred to 
as PET (Pager Entry Terminal). In Europe and North America TAP and IXO are 
utilised interchangeably. 

TNPP Telelocator Network Paging Protocol.  Defined by the PCIA, the TNPP protocol allows 
large scale paging networks to be created. Ideal for hospital paging networks. 

Windows Windows NT, Windows 2000, Windows XP, Microsoft are trademarks of Microsoft 
Corporation 
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6.3 SmartWatch XP User License Agreement 
 

SmartWatch XP User License Agreement 
IMPORTANT-READ CAREFULLY: This License Agreement ("AGREEMENT") is a legal agreement between 
you (either an individual or a single entity) and SmartLink for the software product(s) accompanying this license 
agreement, which include(s) computer software and may include "online" or electronic documentation, 
associated media, printed materials, License Key and a hardware Security Device ("SOFTWARE PRODUCT"). 
By installing, copying, or otherwise using the SOFTWARE PRODUCT or any UPDATES (as defined below), you 
agree to be bound by the terms of this AGREEMENT. If you do not agree to the terms of this AGREEMENT, do 
not install, copy, or otherwise use the SOFTWARE PRODUCT; you may, however, return it to your place of 
purchase for a full refund. In addition, by installing, copying, or otherwise using any updates or other components 
of the SOFTWARE PRODUCT that you receive separately as part of the SOFTWARE PRODUCT ("UPDATES"), 
you agree to be bound by any additional license terms that accompany such UPDATES. If you do not agree to 
the additional license terms that accompany such UPDATES, you may not install, copy, or otherwise use such 
UPDATES. 
Software Product License 
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other 
intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. NOTE: The terms of a 
printed, paper AGREEMENT which may accompany the SOFTWARE PRODUCT supersede the terms of any 
on-screen AGREEMENT found within the SOFTWARE PRODUCT. 
Server And Client 
Client/Server Software. The SOFTWARE PRODUCT may contain one or more components which consist of 
both the following types of software: "Server Software" that is installed and provides services on a computer 
acting as a server ("SERVER"); and "Client Software" that allows a Computer to access or utilise the services 
provided by the Server Software ("CLIENT"). 
1.  GRANT OF LICENSE. This AGREEMENT grants you the following rights: 
Installation and Use. Except as otherwise provided herein, you, as an individual may install and use ONE copy 
of the SERVER component on a single workstation, terminal or other electronic device ("Computer"). If the 
SOFTWARE PRODUCT consists of both Server Software and Client Software which are used together, you may 
also install and use copies of such Client Software on Computers within your organization and which are 
connected to your internal network or across the Internet.  Such Computers running this Client Software may be 
used by more than one individual. 
2.  DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 
Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, 
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is 
expressly permitted by applicable law notwithstanding this limitation. 
Rental. You may not rent, lease or lend the SOFTWARE PRODUCT. 
Support Services. SmartLink International may provide you at their option with support services related to the 
SOFTWARE PRODUCT ("Support Services"). Use of Support Services is governed by SmartLink International 
polices and programs which may change without notice. Provision of Support Services may be charged at the 
discretion of SmartLink International. Any supplemental software code provided to you as part of the Support 
Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this 
AGREEMENT. With respect to technical information you provide to SmartLink International as part of the 
Support Services, SmartLink International may use such information for its business purposes, including for 
product support and development. SmartLink International will not utilise such technical information in a form that 
personally identifies you. 
Termination. Without prejudice to any other rights, SmartLink International may terminate this AGREEMENT if 
you fail to comply with the terms and conditions of this AGREEMENT. In such event, you must destroy all copies 
of the SOFTWARE PRODUCT and all of its component parts. 
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6.4 SmartWatch XP Standard Features 
 

 NOTE: Specifications subject to change without any notice 

 
Recipient capacity .................. 1,000,000 Pagers, mobile phones, DECT handsets or email addresses 
Group capacity .......................................................10,000 Groups (with any combination of recipients) 
Department capacity .............................................................................................. 10,000 Departments 
Concurrent clients ........................................................................................ 10,000 Clients (per server) 
Serial Port capacity .................................................................... 64 x RS232C Serial Ports (per server) 
System Architecture .........................Client/Server, TCP/IP Communications. Server runs as a service 
Internal Communications ................ Encrypted Transport Control Protocol / Internet Protocol (TCP/IP) 
PBX Port capacity ......................................................................................................................64 Ports 
PBX Interface ......................................... Two Wire Analogue Extension (FCC, Austel & CE Approved) 
PBX Messages .......................................................................................... 100 User defined messages 
Alarm capacity ................................ 64,000 Alarm inputs (Either opto-coupled or dry contact closures) 
Escalation capacity .................................................10,000 Call escalations, unlimited escalation steps 
Roster capacity ...................................10,000 Individual Roster Schedules, Unlimited number of shifts 
Reminder Messages ..................................100,000 reminder messages, unlimited forward scheduling 
Terminal capacity ......................64 Operator Terminals (VT100, WYSE or ANSI Compliant Terminals) 
High Level Interfaces ....................................................................................... 64 High Level Interfaces 
Carrier capacity ........................................................ 10,000 Paging/SMS Carriers with modem pooling 
Outbound email ................................................. Sent via Simple Mail Transfer Protocol (SMTP) Client 
Inbound email ........................................... Received via Simple Mail Transfer Protocol (SMTP) Server 
Security Configuration ..........................................User Configurable, each item individually selectable 
Paging Protocols .........................................................................POCSAG CCIR #584 at 512/1200bps 
.............................................................................. Telelocator Alphanumeric Protocol (TAP, IXO, PET) 
DECT Protocols .................................................. Kirk DECT SMS (Short and Long Message Formats) 
...................................................................................................................................Alcatel DECT SMS 
Nursecall Protocols ........................CallGuard, DigiAlert, Dukane, Gladstone, Jeron, Medicom, Sedco, 
...............................................................................Responder IV, Tek-Tone, Vitalcall, Wescom, Zettler 
Slot Machines Protocols ................................Aristocrat (Dacom), Bally, IGT, Tattersalls, Turbo Bonus 
Fire Alarm Protocols ...............................Ampac, FFE 9000/10000, Simplex 4100, Wormald MXL/XL3 
Additional Protocols ......................................................... Citect, Honeywell BMS, Macroview, Modbus 
Server/Client System Requirements ............................................................................... see readme.txt 
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